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Disclaimer
Considerable time, effort and expense have gone into the development and documentation of the
PLPAKTM software. The PLPAKTM software has been thoroughly tested and used. The PLPAKTM
software should be used by engineers with good understanding of concrete behavior, pre-stressing and
structural mechanics. The user accepts and understands that no warranty is expressed or implied by the
developers or the distributors on the accuracy or the reliability of the PLPAKTM software. The user must
explicitly understand the assumptions of the PLPAKTM software and must independently verify the results
produced by the PLPAKTM software.
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Copyright
Copyright © BE4E.com, 2000-2011
All rights reserved.
The PLPAKTM, PLGenTM, PLViewTM, PLCoreManTM, PLPostTM, PTPAKTM, PLTM, PL.EXETM are
registered trademarks of BE4E.com.
The computer program PLPAKTM and all associated documentation are proprietary and copyrighted
products. Worldwide rights of ownership rest with BE4E.com.
Unlicensed use of these programs or reproduction of documentation in any form, without prior written
authorization from BE4E.com is explicitly prohibited.
No part of this publication may be reproduced or distributed in any form or by any means, or stored in a
database or retrieval system, without the prior explicit written permission of the BE4E.com.
Further information and copies of this documentation may be obtained from:
Phone: (732) 325-2616
Skype: youssef.f.rashed (technical director, Dr. Youssef F. Rashed)
e-mail: info@be4e.com (for general questions)
e-mail: support@be4e.com (for technical support questions)
web: www.be4e.com
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PLCoreMan operation diagram
The figure below shows the operation diagram for the PLCoreMan module.

PLCoreMan Philosophy
The PLCoreMan component of the PLPAK is the one responsible for solving the numerical model. The
PLCoreMan contains the PL.exe Command Line Solver as well as several programs which are required to
complete the boundary element solution.
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PLCoreMan Workspace

Menu bar

Command line area
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Load Cases list
area

PLCoreMan menus
The File menu
File | Open (.LC) file
This command is used to open the (.LC) file that was previously saved from the PLGen model.

File | Reload (.LC) file
This command is used to reload the (.LC) file that was previously saved from the PLGen model.
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File | IN2LC tool
This command is used to convert input files written by advanced users to Load case files similar to that
produced by PLGen. This command will produce a dialogue box which is used to input the input
file(.IN), name of loadcase file (.LC) required, name of load case, and name of beam data file (.b). This
dialogue box can then be used to generate the (.LC) file.

File | PL Controls
This command is used to define certain advanced properties of the numerical model. This command will
produce a dialogue box which has controls for PL.exe command solver.
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Line no

Default

Range

Description

1

0

0 OR 1

A flag to print titles section in the output file. Could be equal to 0 (to cancel
printing) or 1 (to print data in the output file).

2

0

0 OR 1

A flag to print basic data section. Could be equal to 0 (to cancel printing) or 1
(to print data in the output file).

3

0

0 OR 1

A flag to print extreme point data section. Could be equal to 0 (to cancel
printing) or 1 (to print data in the output file).

4

0

0 OR 1

A flag to print nodal data section. Could be equal to 0 (to cancel printing) or 1
(to print data in the output file).

5

0

0 OR 1

A flag to print boundary element data section. Could be equal to 0 (to cancel
printing) or 1 (to print data in the output file).

6

0

0 OR 1

A flag to print boundary element connectivity section. Could be equal to 0 (to
cancel printing) or 1 (to print data in the output file).

7

0

0 OR 1

A flag to print boundary conditions section. Could be equal to 0 (to cancel
printing) or 1 (to print data in the output file).

8

0

0 OR 1

A flag to print internal point data section. Could be equal to 0 (to cancel
printing) or 1 (to print data in the output file).

9

0

0 OR 1

A flag to print internal cells data section. Could be equal to 0 (to cancel
printing) or 1 (to print data in the output file).

10

0

0 OR 1

A flag to print internal support data section. Could be equal to 0 (to cancel
printing) or 1 (to print data in the output file).

11

1

0 OR 1

A flag to print output results for the solution of equations procedure. Could be
equal to 0 (to cancel printing) or 1 (to print data in the output file).

12

1

0 OR 1

A flag to print generalized boundary nodal displacements section. Could be
equal to 0 (to cancel printing) or 1 (to print data in the output file).

13

1

0 OR 1

A flag to print generalized boundary nodal tractions section. Could be equal to
0 (to cancel printing) or 1 (to print data in the output file).

14

1

0 OR 1

A flag to print generalized displacements at internal support section. Could be
equal to 0 (to cancel printing) or 1 (to print data in the output file).

15

1

0 OR 1

A flag to print generalized forces at internal support section. Could be equal
to 0 (to cancel printing) or 1 (to print data in the output file).

16

1

0 OR 1

A flag to print number of updated internal cells after solution. Could be equal
to 0 (to cancel printing) or 1 (to print data in the output file).
A flag responsible for boundary element reactions:
0: boundary element reactions will be computed but will not be printed,
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1

0 TO 2

1: boundary element reactions will be computed and printed, and
2: boundary element reactions will not computed.

Line no

Default

9

Range

Description
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A flag responsible for boundary element stress resultants:
0: boundary element stress resultants will be computed but will not be printed,
18

2

0 TO 2

1: boundary element stress resultants will be computed and printed, and
2: boundary element stress resultants will not computed.
A flag responsible for generalized displacements at internal points:

19

1

0 TO 2

0: generalized displacements at internal points will be computed but will not
be printed,
1: generalized displacements at internal points will be computed and printed,
and
2: generalized displacements at internal points will not computed.
A flag responsible for stress resultants at internal points:
0: stress resultants at internal points will be computed but will not be printed,

20

0

0 TO 2

1: stress resultants at internal points will be computed and printed, and
2: stress resultants at internal points will not computed.

21
22

3
1

n
n

23

0

0 OR 1

24

4

n

25

4

n

26

1

0 OR 1

27

1

0 OR 1

28

1

0 OR 1

29

1

0 OR 1

Line no

Default

10

Range

PL version
PL release
0: use the Gauss point number in the .in when calculating the internal point
values, or
1:use the prescribed Gauss point numbers in (24 & 25) when computing the
internal values of displacements and stress resultants
Gauss point number for computing internal point displacements (recall flag no
23)
Gauss point number for computing internal point stress resultants (recall flag
no. 23)
0: use only one cell even if the internal point is located inside it (displacement
calc.)
1:use cell division (4 sub cells) when the internal point is located inside it
0: use only one cell even if the internal point is located inside it (stress
resultant calc.)
1:use cell division (4 sub cells) when the internal point is located inside it

0:do not adjust Qabove for the internal points (use value from input file)
1:adjust value of Qabove for internal points according to the bounded cell (In
this case the flag(27) has to be one to allow the cell division)-NOTE: this also
applied to circular cells and in this case only flag (28) to be one is enough to
make this work, i.e. in case of circular cells flag(27) is ignored in the
adjustment of Qabove
0: will not print the updated Qabove statement in the Log file (recall flag 28)
1: will print the internal cells update statement for Qabove
Description
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30

1

0 OR 1

31

1

0 OR 1

32

1

0 OR 1

40

0

0 OR 1

97

n

n

98

n

n

99

3

0 TO 3

100

0

0 OR 1

101
102

0
0

0 OR 1
0 OR 1

103

0

0 TO 2

104
105
106
107
108
109
110
111
112
113
114
115
116
117
118
119
120
121

0
0
0
0
0
0
0
0
0
0
0
0
0
0
0
0
0
0

0 OR 1
0 OR 1
0 OR 1
0 OR 1
0 OR 1
0 OR 1
0 OR 1
0 OR 1
0 OR 1
0 OR 1
0 OR 1
0 OR 1
0 OR 1
0 OR 1
0 OR 1
0 OR 1
0 OR 1
0 OR 1
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If 1 series of numbers: 15.01, 15.02, 15.03, 15.04, 15.05 will be printed in the
(.STT) file when computing the internal point displacements to indicate the
finished percentage
if 1 series of numbers: 15.1, 15.2, 15.3, 15.4, 15.5 will be printed in the
(.STT) file when computing the internal point stress resultants to indicate the
finished percentage
if 1 the internal collocation point will be moved to the center of the circular
cell if it is inside it. This is to avoid any numerical error.
if 1 TURN OFF WARRNINGS (START FROM WARRNING 320)
if flag no 26 =1 then it compares the area of the divided cells to the original
one; if such ratio is less than 1/n it ignores the contribution of this cell
if flag no 27 =1 then it compares the area of the divided cells to the original
one; if such ratio is less than 1/n it ignores the contribution of this cell
0 TO 3: Adaptive scheme for internal stresses resultant calculations
(recommended 3)
0 OR 1: 0: PL.EXE continue solution & 1: PL.EXE stop after generating
matrices
0 OR 1:no/yes print the [H] matrix in $HMAT$. file
0 OR 1:no/yes print the [G] matrix in the $GMAT$. File
0 TO 2:no/yes [A SMALL]/yes [A BIG] - print the relevant matrix in
$AMAT$. File
no/yes print the [1] matrix in $1MAT$. File
no/yes print the [1b] matrix in $1BMAT$. file
no/yes print the [2] matrix in $2MAT$. file
no/yes print the [3] matrix in $3MAT$. File
no/yes print the [13] matrix in $13MAT$. File
no/yes print the [2b] matrix in $2BMAT$. File
no/yes print the [23b] matrix in $23BMAT$. File
no/yes print the [3b] matrix in $3BMAT$. File
no/yes print the [2d] matrix in $2DMAT$. File
no/yes print the [3d] matrix in $3DMAT$. File
no/yes print the [13d] matrix in $13DMAT$. File
no/yes print the [2bd] matrix in $2BDMAT$. File
no/yes print the [23bd] matrix in $23BDMAT$. file
no/yes print the [3bd] matrix in $3BDMAT$. File
no/yes print the {RHS1} matrix in $RHS1$. File
no/yes print the {RHS2} matrix in $RHS2$. File
no/yes print the [Hcb] matrix in $HCBMAT$. File
no/yes print the [Gcb] matrix in $GCBMAT$. File
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File | Exit
This command is used to close the PLCoreMan window.

The View menu
The commands in this menu are used to view different text files that are used by the model. Each file has
a certain model data. File properties are summarized in the following tables:
Input files definitions
File

Definition

*.in

The model input file

*.run
$run$
$PLctrl$

The run file that contains a flag to specify the mode of
solutions(IRUN flag) and the paths of all other files
Contains the path to the run file to direct the solver to the
problem
Contains some flags that can control the output of the PL core
solver
Output files definitions

File
*.out
*.t
*.u
*.ber
*.bs
*.ips
*.ipu

Definition
A formatted output file
Contains the tractions of the internal cells and boundary nodes
Contains the displacements of the boundary nodes
Contains the displacements of the boundary elements reactions
Contains the stress resultants at the boundary nodes
Contains the internal points displacements
Contains the internal points displacements
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Tracing files definitions
File

Definition

*.stt

A file that stores integers corresponding to stages of solution

*.log

A log files that stores the solution history

The Run menu
The commands in this menu are used to run different components of the PLPAK

Run | PLView
This command is used to run the PLView module, the component of the PLPAK which has the boundary
element model.

Run | PT Cable Calculator
This command is used to run the PT Cable Calculator.

Run | PT Update
This command is used to run the PTUpdate.
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Run |PL.EXE
This command is used to run PL.Exe which is the main solver of the whole model.

As previously stated, the PLPak creates structural analysis solutions using BE model and the Reisner
Plate Equation. The main solver is the “PL.exe” command line which is retrieved from the PLCoreMan,
the PL.exe creates solutions for the boundaries and supports only. In order to find solutions for any other
internal points, two methods are available:
1. Using the PLPost (the post processing component of the PLPAK) to solve for internal points. The
PLPost actually calls the “PL.exe” command line to solve for the internal points, thus, providing
real-solution rather than interpolation. This process increases the accuracy of the produced
results.
2. Defining internal points to be solved from the PLGen.

Run | PLPost
This command is used to run PLPost which is the post processor and result viewer component of the
PLPAK.

The PLPost allows the user to view structural analysis results in different ways under the effect of single
load cases or load combinations (which are defined from the PLPost):
1. Plotting contours either on the whole system or at local points if high accuracy contours are
required.
2.

Drawing strips.
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3. Viewing paths (Strip data that can be imported from text files).
4. Reactions at columns, beams and walls.
5. Straining actions in beams.
Please note that PLPost allows the user to read structural analysis results in any direction, in addition, it
has the ability to calculate design moment using “Wood and Armor” equation.

The Help menu
Help |Help
Opens the Help file of the PLCoreMan.

Help |Show Details
This button is used to show or hide run details.
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Help |Register PLPAK
This button runs the registry dialogue box. This box can be used to check the type of license and get the
core number which is required to license the program.

Help |About
Shows the about dialogue box for the PLPAK.

16

PLPAK V1.02 User Manual - PLCoreMan

Getting Help
The BE4E.com customer support team is always welcoming problems and suggestions of registered
customers. Just send an e-mail including your questions, or your model together with your questions to:
support@be4e.com
Also check our site news at www.be4e.com regularly for Problems and Solutions section and the
Frequently Asked Questions section
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